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BLOCK 3 WORD PROCESSING 
This is the third block of the course “Computer Application in Business”. 
This block briefs about the word processing, their applicability in business 
operations, advanced tools used for it, and also how to create documents 
using word processing. The block on the theme “Word Processing” 
comprises of four units, the detail of which is mentioned below: 

Unit-9: This unit familiarizes the learners with the basics of word processing 
and outlines the various features and advantages of MS Word. This unit also 
explains the various toolbars of the main menu of MS-Word 

Unit-10: This unit helps the learners to understand how to create a new file 
using MS word and MS doc. The unit also explains the file management in 
MS Word as well as the various entering and editing text options available in 
MS Word.  

Unit-11: This unit explains the various advanced options available in MS 
word and its utility. This unit discusses the utility of the mail merge, how to 
create a new data source or link an existing data source as well as how to 
merge, edit, and print the created document. The unit also briefs on the 
various technical and professional writing options for referencing like a 
footnote, citation, indexing, table of content and bibliography, etc. available 
in MS Word. 

Unit-12: This unit makes the learners aware how the different tools discussed 
in previous units can be used for professional writing and effective reports. 
The unit also explains the standard norms for writing these documents. 
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9.0 OBJECTIVES 

After completing this unit, you should be able to: 

start the MS-Word;

understand the various components of MS Word screen;

outline the advantages and features of MS Word; and

understand the basics of MS-Word as a word processing software.

9.1 INTRODUCTION 

In a very common working environment, we draft many notes, letters, 
applications and, other documents. Generally, the senior executive gives the 
outline with one of any letter or documents to be drafted which then is 
created by an employee under him or her. Once developed, the document is 
given to the executive. The executive see-through and suggest changes or 
corrections (if any). Accordingly, the document is changed and finalized. The 
scenario talks about the idea of word processing at the workplace. 

We may find “a number of” software which can be used for word processing 
work some are software based license like MS Word and some are open 
source and web-based such as Google doc, which is available in Google 
Drive.  However, today many of us are using MS Word, the most popular 
word processing software around on the Windows platform. Hence let’s 
discuss MS Word. 

MS Word is one of the software included in the MS Office suite used for 
word processing. The MS Office however is bundle of software developed by 
Microsoft keeping in mind the most common activities of a typical office 
environment. The MS Office, includes MS Power-Point, MS-Excel, and MS-
Access along with MS-word.   

9.2 WORD PROCESSING 

Word Processing is an idea which talks about creating or developing a 
document. When we use and a computer to do so, we require software which 
can provide a platform for it known as word processing software. The word 
processing software helps us creating a document using computer with lots of 
tools and functionalities.  

9.2.1 Advantages of Computer-Based Word Processing 

The computer-based word processing unlike the type-writer based word 
processing enables the users to modify the document without re-typing it. It 
gives us great flexibility in terms of use of the content, modification, and 
formatting.  
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9.2.2 Attributes of Word Processing 

Using word processing software like MS-Word gives us a number of tools to 
“add” several functionalities which can be used not just for creating a 
document but also for many other things like: 

i) Content modification without retyping the whole document 

ii) The paragraphs, sentences or words insertion, modification or deletion 

iii) Easy reproduction of the content by copying the text. It can also be 
move throughout the document 

iv) The page margins can be set for the page as per the need 

v) The Sell-Check feature  can be used to check spellings 

vi) The documents can be merged. 

vii) The mail merge facility can be used to generate multiple copies of a 
letter with a different address 

9.2.3 Various Types of Word Processing Packages 

Though a number of “a number of “add” several” software of such kinds is 
available, following are some of the popular software: 

WordStar: WordStar was the first program to give full word processing 
capabilities to personal computer users at far less cost than the dedicated 
word processors of the time. Many WordStar keyboard commands 
became de facto standards for text manipulation. WordStar was later 
acquired by The Learning Company. A Windows version was also 
created, and all were subsequently disbanded.

Word: MS Word is used most widely which provides advanced word 
processing and Desktop Publishing features.

Word Perfect: WordPerfect is a word processing system that was 
originally produced by Satellite Software International Inc. but is now 
owned by Corel. It was best known for its availability on a large number 
of computers and operating systems. This program reached the height of 
its popularity in the mid- to late-1980s. It has since been eclipsed by 
Microsoft Word in terms of the number of people who use it.

Google Doc: In today's time word processing is done online as well as 
offline. Google Docs is a word processor included as part of a free, web-
based software office suite offered by Google within its Google Drive 
service.
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9.3 SALIENT FEATURES OF MS WORD 

Among all the popular word processing software, MS Word is used most 
widely which provides advanced word processing and Desktop Publishing 
features. The list indicates some of the basic features of MS Word: 

i) It allows you to create and save the document. 

ii) You can add, modify, or delete the text anytime in your document and 
save it for future reference. 

iii) It enables you to set or change the page margins as required. 

iv) It features various formatting options like and a change of font and its 
style. Moreover, you can insert Header and footer in the document. 

v) The Auto Correct feature of MS Word automatically corrects the 
spellings and also suggests the alternate words.  

vi) It also shows document statistics like word count.  

vii) Text can be written in and a columnar style as written in newspapers. 
Also, text boxes can be inserted. 

viii) You can create tables in the document. 

ix) The image and graphics can also be inserted in the document. MS 
Word provides its clip arts or the pictures can be imported from 
outside. 

x) The Mail Merge feature of MS Word helps you generate multiple 
copies of a letter with different addresses. 

xi) MS Word also provides Macros that can be created and used in the 
document. 

xii) Online help is also available to know more about and the various 
features and tools of MS Word. 

Check Your Progress A 

State True or False 

1) Word processor is a Software Package that enables you to create, edit, 
print and   save documents. 

2) WordStar is a popular Word processor.  

3) Changing the size of the margins cannot reformat complete documents or 
parts of the text. 

4) Word has the facility of Macros. 

5) Word does not allow the user to mix the graphical pictures with text 
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1) Open a new document.  

2) Click the File tab.  

3) Click Save As.  

4)  In the Save as type list, click Word 97-2003 Document. This changes 
the file format to .doc.  

5) In the File name box, type a name for the document.  

6) Click Save. 

Check Your Progress B 

1) Multiple Choice Questions 

i) While working in MS Word you have to work with  

a) Mouse only 

b)  Keyboard only 

c)  Both mouse and keyboard 

ii) In MS Word every command is available in  

a) Print  

b) Letter  

c) Icons 

iii) You can go inside MS-Word in the following way 

a) Take the mouse pointer to START button on the taskbar and 
Click the left mouse button. 

b) Take the mouse pointer to START button and click the right 
mouse button. 

c) Move the mouse pointer on the screen. 

2) State True or False 

a) The title bar displays the name of the currently active word 
document. 

b) Two of the most common toolbars are the formatting toolbar and 
the standard toolbar. 

c) The toolbar allows you to format the vertical alignment of the text. 

d) The scroll bar helps you to scroll the content or body of the 
document. 

e) The workspace is the area in the document window where you 
enter/type the text. 

f) Using View option, you can perform editing functions such as cut, 
copy, paste, find and replace, etc. 
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g) Using the Edit option, you can switch over from Normal mode to 
Outline mode. 

h) Using Insert menu, you can insert various objects such as page 
numbers, footnotes, picture frames, etc. 

i) Using Tools menu, you can access to various utilities of word such 
as spell check, macros and mail merge, etc. 

j) Window menu allows you to work with two documents 
simultaneously. 

9.7 LET US SUM UP 

Word Processing is an idea which talks about creating or developing a 
document. When we use and a computer to do so, we require software which 
can provide a platform for it known as word processing software. There are 
various types of Word Processing packages such as MS Word, WordStar, 
Word Perfect, Google Docs, etc. Among all the popular word processing 
software, MS Word is used most widely which provides advanced word 
processing and Desktop Publishing features. 

The important features of the screen of MS Word 2010 are The W Button, 
Title bar, Status bar, Ruler, Scroll bar, Ribbon, etc. 

There are Seven Tabs in MS Word 2010. The first tab is File tab. The File tab 
has commands like Save, Save As, New, Print, etc. The second Tab is Insert 
Tab which consists of many useful options which can be used while creating 
the document in MS Word. Using insert tab, one can add picture, clip art, 
shapes, charts etc. The third Tab is The Page Layout tab which lets you 
manage the look and feel of the document. It also provides a number of 
themes and color schemes which can be applied to your document to have a 
global design.  

The fourth tab is The References Tab which offers a quick way to enter your 
document sources, citations, etc. On the References tab, you will find groups 
like Table of Contents, Footnotes, Citations & Bibliography, and Captions. 
The fifth tab is Mailing Tab. One of the most common features on the 
Mailings tab is the Envelopes and Labels for printing. Sixth tab is The 
Review Tab. The Proofing group is one of the most popular groups on the 
Review tab. The last tab is The View Tab. By the buttons available on the 
Document Views group, you can view your document in different ways. You 
can see the Print Layout, Full Screen Reading, Web Layout, Outline, and 
Draft views. 
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9.8 KEY WORDS 

Title Bar: the title bar displays the name of the document currently being 
active. 

Ruler Bar: The ruler bar is useful to set the vertical alignment of the text in 
the working document. 

Status Bar: It displays information like currently active page number, the 
column and line number of the cursor, and so on. 

Scroll Bar: Scroll Bar available in MS Word enables you to scroll through 
the document up and down or left and right. 

File Tab: File tab is the section that gives you access to file functions such as 
Open, Save, Close, Properties, and Recent file options. 

Quick Access Toolbar: The most frequently used tools/buttons can be stored 
in the Quick Access Toolbar. By default, the Quick Access Toolbar is 
available with tools like Save, Undo, and Redo.  

Ribbon: It gives you quick access to the commands by displaying them up 
front while you work on the document. 

Workspace: The workspace is an area where you create your document by 
typing the text. 

Page Layout Tab: The Page Layout tab lets you manage the look and feel of 
the document. It also provides a number of themes and color schemes that 
can be applied to your document to have a global design. 

References Tab: It offers a quick way to enter your document sources, 
citations, etc. 

9.9   ANSWERS TO CHECK YOUR PROGRESS 

Check Your Progress A 

1)   (a) True  (b) True  (c) False  (d) True  (e) False 

Check Your Progress B 

1)   (i) c  (ii) c (iii) a 

2)   (a) True  (b) True  (c) False  (d) True  (e) True 

     (f) False  (g) False  (h) True (i) True (j) True 
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9.10  TERMINAL QUESTIONS 

1) What do you understand by Word processing? Give examples. 

2) Describe the important features of MS-Word. 

3) Describe the various options available in the main menu bar of MS-
Word. 

4) What are the different types of toolbar? 

5) Explain two methods to start MS-Word. 

 

 

Note: These questions are helpful to understand this unit. Do efforts for 
writing the answer of these questions but do not send your answer to 
university. It is only for yours practice. 
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UNIT 10  WORKING WITH WORD PROCESSING 

Structure 

10.0 Objectives 

10.1 Introduction 

10.2 File Management in MS Word 
 10.2.1 Create a Document 
 10.2.2 Open an Existing File 
 10.2.3 Saving File Option I (Save Command) 
 10.2.4 Saving File Option II (SaveAs Command) 
 10.2.5 Auto Saving Document 
 10.2.6 File Tab with Recent Option 
 10.2.7 Save and Exit 
 10.2.8 Quitting Word 
 10.2.9 Preview and Printing a Document 

10.3 Entering and Editing Text 
 10.3.1 Coping Text 
 10.3.2 Undo Repeat 
 10.3.3 Find and Replace Text 
 10.3.4 Character Formatting 
 10.3.5 Line Spacing 
 10.3.6 Alignment 
 10.3.7 Border and Shading     
 10.3.8 Page Breaks 
 10.3.9 Column 
 10.3.10 Change case  
 10.3.11 Adding and Removing Numbers and Bullets 
 10.3.12 Indenting 
 10.3.13 Margins 
 10.3.14 Header and Footer 
 10.3.15 Spell Checking the Document 
 10.3.16 Creating and Managing Tables 
 10.3.17 Working With Graphics  
 10.3.18 Word Art 
 10.3.19 Insert Picture/Clip Art 
 10.3.20 Smart Art Graphics 

10.4 Working with Google Docs 

10.5 Comparison between MS-Word and Google Docs  

10.6 Let Us Sum Up 

10.7 Key Words 

10.8 Answers to Check Your Progress 

10.9 Terminal Questions 
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10.0  OBJECTIVES 

After completing this unit, you should be able to: 

understand how to create a new file or open an existing file in MS-Word; 

understand how to edit the documents in MS-Word; 

understand working with MS doc; and 

understand the compatibility of MS-Word and Google docs. 

10.1  INTRODUCTION 

When it comes to word processing, Microsoft Word is the gold standard. As 
part of the Microsoft Office productivity suite, more than one billion 
computer users rely on the program every day. Even though so many 
consumers use Microsoft Word, not everyone knows how to maximize the 
capabilities of the program. Word is packed with a multitude of features that 
can help make the creation of documents, reports, and text files easier. This 
unit makes you understand the basics of MS Word and about its interface, the 
process of creating a word document and drafting your letters and how to 
modify your contents and save the document and how to move your contents 
within the documents using cut, copy and paste, etc. To format the document 
various formatting tools available like alignment, font style, page break, 
border, and shading, etc. are also explained. The unit will also explain few 
advanced features of MS Word like Header and Footer, Tab setting, inserting 
table, word art, use of formula, working with graphics, use of pictures and 
clip art, and SmartArt. Along with MS word Google docs is also popular 
these days that make our work much easy. The later part the unit has 
explained the working with Google docs along with their comparison with 
MS word. 

10.2  FILE MANAGEMENT IN WORD 

As of now, you must be familiar with most of the basic features of MS Word. 
Let us understand to create a file or a document where you can start word 
processing and draft your text matter. By default, a new blank document 
opens when you launch the MS Word.   

10.2.1 Create a Document 

Although it is very easy to start working with a basic document in MS Word 
2010, however, if you wish to create another document you simply have to 
follow a few steps to do so. Go to File Tab and click on “New” in the left 
column, and then double click on “Blank Document” to create a new 
document window. 
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10.2.5 Auto Saving Document 

It is always a good idea to periodically save your work in MS Word. This can 
be done automatically using AutoSave option. All you have to do is to choose 
the AutoSave and its period i.e. frequency of saving by clicking on “Options” 
in the File menu. 

 

Fig. 10.7: Auto Saving Document 

10.2.6 File Tab with Recent Option 

The “Recent Option” of the File tab gives you a quick option to access your 
other documents. You can also recover the file by clicking on the Recover 
Unsaved Document option at the bottom of the page if you have accidentally 
deleted document 
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1) Click the File tab, and then click Print. To go back to your 
document, click the File tab.  

2) A preview of your document automatically appears. To view each 
page, click the arrows below the preview.  

b)  Print  

1) The Print tab is the place to go to make sure you are printing what 
you want.  

2) Click the File tab.  

3) Click the Print command to print a document.  

4) Click the Print button to print your document.  

5) This dropdown shows the currently selected printer. Clicking the 
dropdown will display other available printers.  

These dropdown menus show currently selected Settings. Rather than just 
showing you the name of a feature, these dropdown menus show you what 
the status of a feature is and describes it. This can help you figure out if you 
want to change the setting from what you have.  

10.3 ENTERING AND EDITING TEXT 

After having created your document, you are now ready to enter the text. 
Whatever text you write would appear in the workspace on the current 
location of the cursor. MS Word automatically manages the right margin of 
the document while you enter the text in the document. Once you write a 
word, the insertion point moves automatically to the next line. To change the 
line or the paragraph at any time you need to use Enter key ( ). Editing the 
document means making the desired correction in your document. Editing of 
a document helps you in 

Deleting a part of the text. 

Moving text from one place to another. 

Copying text from one place to another  

These editing activities can be performed easily in the MS Word, however, 
you are required to first select the text or the block of text before you go 
ahead with editing options. You can select the text using a mouse or by 
simultaneously pressing Shift and arrow keys. You can refer to the table 
below for various selection options based on the “Click and Drag” approach. 
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Fig. 10.13:  Changing Font, Size and Color of the Text 

You can use any of the Font from the list of the fonts.  

Indira Gandhi National Open University        Times New Roman font 

The size of the font can also be changed using font size list. 

Indira Gandhi National Open University 12. 
Indira Gandhi National Open University 18. 
Indira Gandhi National Open University 24. 
Also, more options are used to change the look and feel of the character from 
the dialog box. 

a) Boldface: To make any character or word Boldface, you have to select
the character or word and then click on the Bold icon from the toolbar

IGNOU is in Boldface style 

b) Italics: To make any character or word italic, you have to select the
character or word and then click on the italic icon from the toolbar

c) Underline: To make any character or word Underline, you have to select
the character or word and then click on the Underline icon from the toolbar 

IGNOU is underlined 

B 

U
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Boldface, Italics, and Underline button toggle between on and off. When you 
want to remove boldface, italics or underline, you can select the text again 
and click on Boldface, Italics or Underline button to remove it.The Bold, 
Italic and Underline buttons can be pressed to have the text in Bold, italic or 
underline and these can be pressed again to withdraw the effect. This is called 
toggle option. MS Words offers many toggle icons which can be used as and 
when required. 

(d) Subscripts and Superscripts: The subscripting and superscripting 
options can be used to have the subscripting and superscripting. To do so 
you need to select the text and then click on the subscript or superscript 
icon available in font group toolbar 

Examples:  Superscript 50th 
Subscript At 

10.3.5 Line Spacing 

The line spacing plays a very important role in formatting the letter or any 
other matter. You can adjust the line spacing as per the need by clicking the 
Paragraph Group in the Home Tab 

 

Fig.10.14: Line Spacing 

The Single or Double line spacing can be selected as per the requirement. An 
example of single-spacing text and double-spacing text is given 

a) Single Line Spacing: Indira Gandhi National Open University known 
as IGNOU is a Central University located at Maidan Garhi, New Delhi, 
India. Named after former Prime Minister of India  Indira Gandhi, the 
university was established in 1985. 

b) Double Line Spacing: Indira Gandhi National Open University known 
as IGNOU is a Central University located at Maidan Garhi, New Delhi, 
India. Named after former Prime Minister of India  Smt. Indira Gandhi, 
the university was established in 1985. 

10.3.6 Alignment 

The default alignment of MS Word is Left Alignment. However, you can 
have Right or Centre Alignment as required. 

 

Fig.10.15: Alignment 
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a) Left-Aligning Text: To have the left alignment, you have to select the 
content and then click on the Left Alignment icon from the formatting 
toolbar 

b) Right-Aligning Text: To have the right alignment, you have to select 
the content and then click on the right Alignment icon from the 
formatting toolbar 

c) Centre-Aligning Text: To have the centre alignment, you have to select 
the content and then click on the centre Alignment icon from the 
formatting toolbar. To have different alignment, you can also select the 
Paragraph toolbar. In the Paragraph tool the Alignment drop-down list 
you can choose the option to get the desired effect  

d) Justification: Once the alignment is done, the paragraph can be justified 
using, Justification tool. To justify the paragraph you have to select the 
paragraph first and then select on the Justify icon from the formatting 
toolbar 

10.3.7 Border and Shading 

The borders and shadings can be added on the document to make your 
document more beautiful. 

a)  Borders: The Border can be applied on to the entire page or any 
specific paragraph in your document. You can apply borders through 
Border toolbar as shown in the figure. 

 

Fig. 10.16: Borders Toolbar 

Different border options can be used to apply the border in the document 
as per need. You can also decide about the thickness of your borderlines. 
The drop-down list available in the Border toolbar allows you to select 
the desired thickness for the borderline. 
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b)  Shading: Like borders, shadings can also be applied to the document. It 
can be applied to the entire page or a specific paragraph. The shading 
option is used to make your content more noticeable in the document. 
You can use Shading toolbar to explore various shading options 
available for you as depicted in the figure. 

 
Fig. 10.17: Shading Text 

Alternatively, you can use the Borders and Shading option from the Format 
menu bar. The following dialog box will appear as shown in the Fig. The 
various shading options can also be assessed using “Border and Shading” 
option available in the Formatting Group. 

 

Fig.10.18:   Customizing Borders and Shading 

 

10.3.8 Page Breaks 

Although, MS Word manage the pages and add new page automatically once 
the current page on which you are writing is full called the Soft Page Break. 
However, you can also break the page as per your wish which is known as 
Hard Page Break. To insert a new page, you have to put your cursor on the 
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location where you want a page break and click on the “Page Break” option 
available in the Insert tab. The shortcut keys for Page Break are Ctrl+Enter. 
The pages can be removed as well using backspace or Delete key in the 
keyboard. 

10.3.9  Column 

Sometime, you are required to prepare your document by writing your text in 
multiple columns as done in a newspaper or a magazine. The contents are 
written in columns where the text runs down the left-most columns till the 
bottom of the page and then wraps to the next column. The number of 
columns can be decided and fixed before initiating the word processing; even 
you can create the columns after you are done with the text writing. The Page 
Layout tab can be explored to find the “Column” option and select the 
desired number of columns as per the requirement. The size of the column 
can also be adjusted as per the need. Either you can select the Preset options 
or else the width and spacing can be specified.  

 

Fig. 10.19: Column selection 

10.3.10 Change Case 

To prepare your document with different cases, you can use the “Change 
Case” option provided by MS Word. You have to select the paragraph where 
you want to apply the change case option and then click on the “Change 
Case” in the Home, tab to get the dialog box as shown in the figure. 
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Fig. 10.20: Changing Case 

The following five different types of text cases are shown in the dialog box. 
MS Word offers you the following five types of text case as explained below: 

a) Sentence case: This option will make the first letter of each sentence in 
upper case. 

b) Lower case: If you select the “Lower Case” option, all the characters of 
the selected text would be changed in the lower case 

c) Upper case: If you select the “Upper Case” option, all the characters of 
the selected text would be changed in the lower case 

d) Title case: The “Title Case” makes the first character of each word in the 
Upper Case. 

e) Toggle case: The Toggle Case makes all the lower case characters into 
upper case and all the upper case characters into the lower case for the 
selected paragraph. 

10.3.11 Adding and Removing Numbers and Bullets 

Many times, you require presenting some of the text in bullet points or in 
numbered form. Writing the text in a bulleted or numbered form improves 
the presentation of your content in the document. MS Word allows you to 
add bullets or numbers to the text. To add numbers to a specific paragraph, 
select Home Tab Paragraph Ribbon then on Bullets and Numbering. A 
dialog box will appear as shown in the Fig. 10.21 The numbers or bullets can 
be added using the “Bullet and Numbering” option available in the Home tab.  

 

 

Fig.10.21:  Bullets and Numbering 
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In order to apply bullets or numbers to your text, you need to select the text 
first and then click on the “Bullet and Numbering” option. You can click 
Bullet icon to add bullets and number icon to add numbers for your text. 
Different styles of Bullet and Numbering can also be selected as per your 
needs. To remove the bullet or numbering, you have to select the numbered 
or bulleted text and click on the number or bullet icon accordingly  

Check Your Progress B 

State whether the following statements are True or False. 

a) Changing the style of your font does not come under formatting. 

b) Superscripting and Subscripting can be done in MS Word. 

c) The default Ms-Word alignment for all the text is the Right Alignment. 

d) You cannot apply the border on to the entire page. 

e) MS Word manages the page and add a new page when the current page 
is full. 

f) Columns of unequal widths cannot be created using the Column toolbar. 

g) The shading makes the text more noticeable. 

h) MS Word offers4 types of change case options. 

10.3.12 Indenting 

The Indenting is used to clearly demark the lines or paragraphs from the rest 
of the text. The indenting can be done using Paragraph Group of Home Tab. 
The figure shown below would appear on Line and spacing option. The 
dialog box as shown above provides you with all the necessary options 
through which you can set the left or right indents. You can also set the 
indents by dragging the indent marker available on the ruler. 

 

 

Fig.10.22: Indenting Paragraph 
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10.3.13 Margins 

The margin plays a very important role in any document. Though MS Word 
by default sets the margin for the document, however, you can also set 
margin using the Ruler bar, or else it can be adjusted using the margin 
boundaries by clicking and dragging it as shown in fig. 10.23. 

 

 

 

Fig.10.23: Margin Setting using Ruler bar 

The margins can also be set by using the Page Setup Group from the Page 
Layout Tab. On clicking the Margins icon from the Page Setup Group 
following dialog box will appear. From the dialog box, you can specify the 
Top, Bottom, inside, and outside margins. The new settings for the margins 
can be applied either to the whole document or a particular section of the 
document.  Selecting the required option from the drop-down list of apply to 
does this. The dialog box enables you to set all the margins i.e. Top, Bottom, 
Left, and Right. You can apply the new setting for the whole document or for 
a specified block of text. 

10.3.14 Header and Footer 

Sometime you will find a situation where you have to put some common text 
as a heading and which would appear at the top of each page of the document 
or a common text which should appear at the bottom of the page throughout 
the document. So instead of writing the content all over again and again for 
each page, you can use the Header and Footer option of MS Word. The 
Header and Footer option is a very important tool and is used very 
extensively while preparing the document. The Header and Footer option can 
be applied by clicking on Header and Footer options available in Insert Tab. 
When you click on Header icon a box as shown below would appear to allow 
you writing the text for Header to appear at the top of every page. 

-----Header------------------------------------------------------------------------------- 

 

 

Fig. 10.24: Header Area 
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Like Header, you can go to Footer option by clicking on Footer icon, a box at 
the bottom of the page will appear where you can write your text for the 
Footer.  

-----Footer-------------------------------------------------------------------------------- 

 

Fig. 10.25: Footer Area 

You can use the Header and Footer toolbar buttons in Header & Footer 
Group in The Insert Tab to insert the page number, the current date, or the 
current time into your Header or Footer. The Header & Footer Group can be 
used to apply page number, date, time, etc. in the Header and Footer section 
of the document.  The page numbers can be inserted using the Page Number 
tool of Header & Footer Group as shown in the figure below 

 

 

Fig. 10.26: Header and Footer 

10.3.15 Spell Checking the Document 

Spell Check is a very important tool of MS Word which informs you about 
your spelling mistakes and suggests the correct word. The spellings are 
checked by referring to the main dictionary of the MS Word; however you 
can also create your own custom dictionary. The Spell Check tool can be 
invoked by clicking on the Spell Check tool available in the Proofing Group 
of Review Tab  

 

Fig.10.27: Spellchecker Tool 

The Spelling & Grammar tool over see the whole document and displays 
with a dialog box whenever any error is found. The tool also provides you 
with suggestions to correct the word(s) in the suggestion box for the words 
which are not found the main dictionary of MS Word. 
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Fig.10.28: Inserting a Table 

b)   Entering text into Table 
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Fig. 10.31

c) Delete Shapes: If you want to 
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d) Inserting Text Boxes: The 
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Fig. 10.32: Clip Art 
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corners of the object 

ved your images or even 

 

o follow the below steps: 

on group available in the 

option at the right hand 

rd and click on Go to get 

rom the list appeared by 

r desired picture from the 
o get it pasted in your 

from a file you need to 

on group from the Insert 

can browse the picture in 

ck on the Insert button to 

s, text boxes, shapes, and 
es or return them to their 
e objects like shapes, text 
o be cropped as per the 

eeds to be selected first 

with a ball will appear on 



3) You can drag the size hand
size.  

Fig. 10.33

e)   Cropping A Picture: The crop
edges to remove the unwanted
following the steps as given be

1) Select the picture by clicki

2) Click on the Crop tool in th

3) The picture will show the
picture called crop handle
get the picture cropped.  

4) After cropping the picture,

10.3.20 SmartArt Graphics

The SmartArt Graphics are used to
information this tool can be used to
images. SmartArt helps you with q
steps. Different kind of SmartAr
Hierarchy, Cycle, or Relationship. 
of graphics to use.  

a) Create a SmartArt Graphic  

1) You need to select the Sm
Insert Tab 

2) You will be shown, cho
choose the type and layout

3) Now you can enter the text

Clicking [Text] in the Text p

Copy and paste the text from

 

dle accordingly to increase or decrease the 

 

3: Sizing Graphics 

pping tool is used to trim the picture by its 
d area. You can easily crop the picture by 
low: 

ing on to it 

he Size group from the Picture Tab 

e thick black line across the edges of the 
. The crop handle can be drag inwards to 

, click anywhere outside the picture. 

s 

o create a pictorial representation of your 
o quickly represent your information using 
quick illustration in just two-three simple 
rt graphics can be chosen like Process, 
Each category comprises or many layouts 

martArt tool from the Illustration group in 

oose a SmartArt Graphic dialog box, to 
t as per your need 

t by:  

pane  

m another location, in the Text pane 
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b) Add

1) 

2) 

3) 

4) 

T

T

T

c)  For

You

1) 

2) 

3) 

4) 

5) 

Fig. 10.34: SmartArt Graphics 

d or Delete Shapes in SmartArt Graphic  

Click the SmartArt graphic that you want t

Click the existing shape that is located clo
to add the new shape.  

Under SmartArt Tools, on the Design tab
group, click the arrow under Add Shape.  

Do one of the following:  

To insert a shape after the selected shape, clic

To insert a shape before the selected shape, cl

To delete a shape from your SmartArt grap
want to delete, and then press DELETE
SmartArt graphic, click the border of you
then press DELETE.  

rmat SmartArt Graphic  

u can apply color variations to the shapes in y

Click your SmartArt graphic.  

Under SmartArt Tools, on the Design tab,
group,  

Select the SmartArt Style you wish to apply 
or 3-D effects.  

In the SmartArt Styles group, you can also
further modify your SmartArt graphic.  

Click the colour variation that you want. 

 

to add another shape to.  

osest to where you want 

b, in the Create Graphic 

ck Add Shape After.  

lick Add Shape Before.  

hic, click the shape you 
E. To delete your entire 
ur SmartArt graphic and 

your SmartArt graphic.  

, in the SmartArt Styles 

to add line styles, bevels 

o click Change Colors to 



Fig. 10.35: Form

10.4 WORKING WITH

Google Docs is a free, web-based w
of its complete office suite. It can 
documents. You can even downloa
so it has a standard Word extension
Google Docs will let you export. G
Docs is an internet browser driven
the device. You can access docs on
Microsoft Word. 

The other main services included in
and Slides (PowerPoint).Google 
platforms; all you need is an intern
the case of mobile, the applicable a
brunt of the heavy lifting while 
supports several different file types
and “.odt”, making it easy to view a
from Google Drive. And since Do
share and collaborate with multipl
revisions, changes and suggestions 

10.5 COMPARISON BE
GOOGLE DOCS 

A word processor is software or a d
print documents. It enables you to w
on a screen, modify it by enteri
keyboard, and print it. Of all comp
most common. Whereas, Google D
part of free, web-based software, 
Google Drive service. This service 
discussing in Unit-17 and Google
presentation program respectively
Office file formats. Microsoft Wo

 

mat Smart Art Graphics 

H GOOGLE DOCS 

word processor offered by Google as part 
be used to open and edit Microsoft Word 

ad your Google Docs as a Word document 
n (.docx). But that's not the only file format 
Google, on the other hand, is free to use. 

n app and does not need to be installed on 
n any browser or operating systems, unlike 

n the cloud-based suite are Sheets (Excel) 
Docs is available on all devices and 

net connection and a web browser (or, in 
apps). Google does the rest and handles the 
it runs the software in the cloud. Docs 
s, including “.doc”, “.docx”, “.txt”, “.rtf”, 
and convert Microsoft Office files directly 
ocs is an online word processor, you can 
e people on the same document, tracking 
all in real time. 

ETWEEN MS-WORD AND 

device that allows users to create, edit, and 
write text, store it electronically, display it 
ing commands and characters from the 
puter applications, word processing is the 

Docs is a word processor which includes as 
office suite offered by Google within its 
also includes Google Sheets which we are 
e Slides in Unit-13), a spreadsheet and 
. The app is compatible with Microsoft 
ord has been around longer than Google 
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Docs and remains exceptionally popular today. Millions of individual users 
and companies still pay big money to use Word. So, how do Google Docs 
and Word compare? Below given are some points of the comparison between 
Google docs and Word. 

Google Docs is free with a Google account. Microsoft Word must be 
purchased as part of a Microsoft Office package, which includes other 
Microsoft products such as PowerPoint, Excel, and Outlook. 

The Home and Business packages run from $69.99 (for an individual 
user at home) up to $150 (for an individual user at work) for an annual 
membership. Google Docs, on the other hand, allows you to collaborate 
with any number of people, anywhere in the world, for free. 

Another differentiating factor is that, with Google Docs, all of your work 
is saved to the Cloud. That means you won't lose your 20-page report 
even if your laptop croaks.  With Microsoft Word, your documents live 
on your computer; your co-workers can't check them out unless you save 
and share them via email or the like. 

Check Your Progress C 

State whether the following statements are True or False: 

a) You can align text and numbers at a tab stop left, right, center, or 
justified. 

b) To indent the text paragraph option is to be selected. 

c) The Header appears at the bottom of the page. 

d) Footer is used to set the margins. 

e) The Table can be created using Insert Tab. 

f) The table is nothing but the intersection of columns and rows. 

g) Delete row option can be used to Delete the Table. 

h) The Formula feature helps you to calculate the values using a simple 
formula. 

i) MS Word prints 4 copies of the document by default. 

10.6 LET US SUM UP 

A word processor is software or a device that allows users to create, edit, and 
print documents. It enables you to write text, store it electronically, display it 
on a screen, modify it by entering commands and characters from the 
keyboard, and print it. Of all computer applications, word processing is the 
most common. This unit has explained the various features and functions of 
MS word such as file management and editing of documents and texts.  
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For example, using copy function you can put the same character, word, or 
block of the text in different places of the document. The Undo and Redo 
options are used to cancel the previous command and to repeat the previous 
command respectively. Find and Replace option is used to find any word or 
text in the document the option also allows you to replace the text with the 
new one. Characters can be formatted MS Word, you can change the font of 
the character, size of font, its style, color, etc. using character formatting. 
Line spacing plays a very important role in formatting the letter or any other 
matter. The Single or Double line spacing can be selected as per the 
requirements.  

The borders and shadings can be added to the document to make your 
document more beautiful. Different border options can be used to apply the 
border in the document as per need. You can also decide about the thickness 
of your borderlines. The shading option is used to make your content more 
noticeable in the document. It can be applied to the entire page or a specific 
paragraph. 

MS Word allows you to add bullets or numbers to the text. The Indenting is 
used to demark the lines or paragraphs from the rest of the text. The 
indenting can be done using Paragraph Group of Home Tab. Though MS 
Word by default sets the margin for the document, however, you can also set 
margin using the Ruler bar, or else it can adjust using the margin boundaries 
by clicking and dragging it. 

Header and Footer option is a very important tool and is used very 
extensively while preparing the document. The Header and Footer option can 
be applied by clicking on Header and Footer options available in Insert Tab. 
When you click on the Header icon a box would appear to allow you to write 
the text for Header to be appeared at the top of every page and footer at the 
end of every page. MS word also allows the features like creating a table; 
spell check, inserting pictures, clip arts, word arts, smart arts, etc. 

Google Docs is a free, web-based word processor offered by Google as part 
of its complete office suite. It can be used to open and edit Microsoft Word 
documents. Microsoft Word has been around longer than Google Docs and 
remains exceptionally popular in today’s scenario. Millions of individual 
users and companies still pay big money to use Word. Google doc has got 
some more advanced tools than MS word Google Docs, all of your work is 
saved to the Cloud. That means you won't lose your 20-page report even if 
your laptop cracks. With Microsoft Word, your documents live on your 
computer; your co-workers can't check them out unless you save and share 
them via email or the like. 

 



Word Processing 

202 

10.7 KEY WORDS 

File Management: File management is the process of administering a system 
that correctly handles digital data. Therefore, an effective file management 
system improves the overall function of a business workflow. It also 
organizes important data and provides a searchable database for quick 
retrieval. 

Header: A header is a region at the beginning of each file where 
bookkeeping information is kept. The file header may contain the date the 
file was created, the date it was last updated, and the file's size. 

Footer: A footer is an area at the bottom of a document page that contains 
data common to other pages. The information in footers may include page 
numbers, creation dates, copyrights, or references that can appear on a single 
page, or on all pages. 

Table: A table is a grid of cells arranged in rows and columns. Tables are 
useful for various tasks such as presenting text information and numerical 
data. In Word, you can create a blank table, convert text to a table, and apply 
a variety of styles and formats to existing tables. 

Row: In the context of a relational database, a row—also called a tuple—
represents a single, implicitly structured data item in a table.  

Column: The columns in a table are the set of facts that we keep track of 
about that type of object. A column is also called an attribute. 

Indenting: The Indenting is used to clearly demark the lines or paragraphs 
from the rest of the text. The indenting can be done using Paragraph Group of 
Home Tab. 

Word Art: Word Art feature of MS Word is basically used to beautify your 
text. You can write your text in different ways using the Word Art options 
available. 

SmartArt: The SmartArt Graphics are used to create a pictorial 
representation of your information this tool can be used to quickly represent 
your information using images 

Clip Art: Clip Art is the term given to pre-made images that are ready for 
use in your Microsoft Word documents. There are many Clip Art categories, 
such as Christmas, Special Occasions, People, Business, Decorative 
Elements, Animals, Cartoons, etc. 
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10.8 ANSWERS TO CHECK YOUR PROGRESS 

Check Your Progress A 

a) True, b) True, c) False, d) True 

Check Your Progress B 

a) True, b) False, c) True, d) False, e) True, f) True, g) False, h) True 

Check Your Progress C 

a) True,  b) True, c) False,  d) False, e) True, f) False, g) True, h) True,  
i) False 

10.9 TERMINAL QUESTIONS 

1) Explain the process of creating a file step by step. 

2) What is the process to find the word IGNOU and replace it with 
University? 

3) How would you save any document? 

4) Write the steps to open a file for editing. 

5) Explain the different types of alignment available in MS-Word. 

6) How would you use Border and Shadings in your document? 

7) How would you create a document with 1.5 line spacing? 

8) Explain the steps to a create page break. 

9) Explain the process of inserting the Table in your document. 

10) List steps for creating a bulleted list. 

 

Note: These questions are helpful to understand this unit. Do efforts for 
writing the answer of these questions but do not send your answer to 
university. It is only for yours practice. 
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UNIT 11 ADVANCED TOOLS USING WORD 
PROCESSING 

Structure 

11.0  Objectives 

11.1  Introduction 

11.2  Meaning of Mail Merge 

11.3  Components of Mail Merge 

11.4  How to Merge Mail 
 11.4.1  Create Your Data Source 

 11.4.2  Create the Main Document 

 11.4.3  Merging Document with Data Source 

11.5  Equation Editor 
 11.5.1 Starting Equation Editor 

 11.5.2 Creating New Equations 

11.6  Tracking 
 11.6.1  Track Changes 
 11.6.2  Tracking Options 
 11.6.3  Reviewing Changes 

11.7  References 
 10.7.1  Footnote or Endnote 
 10.7.2  Indexes 
 10.7.3  Table of Content 
 10.7.4  Bookmarks 
 10.7.5  Cross-references 
 10.7.6.  Citation 
 10.7.7  Placeholders 
 10.7.8  Bibliography 

11.8  Let Us Sum Up 

11.9  Key Words 

11.10  Answers to Check Your Progress  

11.11  Terminal Questions 

11.0 OBJECTIVES 

At the end of this unit, you should be able to: 

understand the utility of the feature mail merge; 

create a master document for mail merge; 

create a data source or how to link an existing data source; and 

merge, edit, and print the created document. 



Advanced Tools Using
Word Processing

205

11.1 INTRODUCTION 

The Mail Merge feature of MS Word is an important feature for everyday 
office work for mailing documents to different individuals. It makes the job 
simpler and easy to execute. Many times, in the office environment we need 
to send the same content of a letter to different individuals or addresses. With 
the use of mail merge, we can send the same letter to a number of persons 
without typing the receiver’s detail again and again. We can also print 
envelops, labels of different addresses using this feature. 

11.2 MEANING OF MAIL MERGE 

In an office environment, many times a similar type of letter or document is 
needed to be sent to many individuals at different destinations. These 
documents may contain the receivers’ information like name, address, phone 
number, etc. with the main content. The purpose is to individualize the 
information for example a personal invitation to meeting or function.  If the 
recipients are smaller in number it can be done by typing the information of 
each individual and making copies of the same letter. But if the number of 
recipients intended ate huge than manual typing may be time-consuming and 
prone to errors. 

Mail merge eliminates such issues and hundreds of letters can be created with 
individualize content with the main content within minutes. The volume of 
the recipients becomes immaterial Mail merge, in other words, is the process 
of transferring selected information from one document to another document. 

11.3 COMPONENTS OF MAIL MERGE 

To execute Mail Merge following two main components are required: 

The letter also called the main document which needs to be merged. 

Data source with proper header row which contains the information of 
the individuals for whom letter to be generated. Header row for the data 
source is important because it plays the role of linkage between data and 
document. 

Mail merge options of the MS Word read the data and merge it with the main 
document to generate letters for all in the data source.  

  Main Document   Data Source 

  

 

 

 
Fig. 11.1: Mail Merge Options 



Word Processing 

206 

1) Main Document 

In mail merge, Main document is the common letter, which contains the 
common content for each of the merged documents. It contains field 
names which are inserted at required places in the document, which 
contains the instruction for carrying out the merge. 

2) Data Source 

Data source is the records of individuals to who letters to be sent also 
called Data File. The information stored in the data files is brought into 
main document by mail merge. The data file table should contain a 
column for each category of information’s like for name one column, for 
phone no another column. Header row the first row of the table. It 
contains field names which indicate the type of information in each 
column. Each filed name must be unique and must begin with an 
alphabet letter. 

3) Form Letter 

Form letter is the document created out of mail merge, which contains 
the content of the main document with each piece of information from 
the data source. So, if we have 50 rows of information in the data source 
form letter will be of 50 pages with the same content but changed field 
information from the data source. 

Check Your Progress A 

1) What is the utility of mail merge? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

2) What are the components required for the mail merge? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

3) What is form letter? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 



4) Why header filed important for

…………………………………

…………………………………

…………………………………

…………………………………

…………………………………

11.4 HOW TO MERGE

The process for mail merge is a thre

Create the data source (you m
format) 

Create the main document 

Merge the data with document 

11.4.1 Create Your Data Sou

Create an excel spreadsheet, cr
Address, City, State, Pin Code,

It is preferred that name shou
Name in two separate columns 

If you are using currency symb
rather change the column to tex
up in your letter. 

Fig. 11.2

r mail merge? 

……………………………………………. 

……………………………………………. 

……………………………………………. 

……………………………………………. 

……………………………………………. 

E MAIL 

ee-step process 

may already have it in primarily in excel 

urce 

reating a header for each field e.g. Name, 
, Email Id, etc. 

uld be divided into First Name and Last 
for filtering alphabetically if needed. 

bol in amounts do not use excel formatting 
xt, otherwise, the dollar sign will not show 

 

2: Creating Data Source 
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11.4.2  

Prepare 
insert pl
source e

11.4.3  

Und
on ‘

A w
Doc

Create the Main Document 

the letter in MS Word. While creating a le
laceholders where you intent to merge the
.g. [City], [State] etc. 

Merging Document with Data Sou

der ‘Mailing’ Tab in MS Word click on ‘Star
Step by Step Mail Merge Wizard’ 

Fig. 11.3: Merging Documents for M

window will appear to the right of your docum
cument type’ For this example choose ‘Letter

Fig. 11.4: Selecting the Document T

etter it is a great idea to 
e information from data 

rce 

rt Mail Merge’ and click 

 

Mail 

ment that will say ‘Select 
r’ 

 

Type 



At the bottom, click on Next: S

The next step will read ‘Select 
already prepared leave this 
Document’. 

Next click ‘Select Recipients
existing List’ with the ability br

Click on the ‘browse’ button 
you have created in Excel. 

On finding your document cl
‘Select Table’. Click Okay. 

Fig. 11.5:

Fig. 11.6

You can then see the data tha
leave certain names you may n

 

Stating Document.  

Starting Document’. If you have the letter 
section and choose ‘Use the Current 

’ at the bottom. You will find ‘Use an 
rowse for your list. 

and find your list on your computer that 

lick ‘open’, and a box will appear says 

 

 Select Recipients 

 

: Selecting Table 

at you have created. You can also choose 
ot require for this letter then click ‘ok’.  
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The
‘Cu
the 

A

Fig. 11.7: Mail Merge Recipients

e table will close and the dialogue box on
urrently Your Recipients Are Selected From’ 
excel spreadsheet document. 

Fig. 11.8: Selecting Recipients 

At the bottom of the document select ‘Write y

 

s 

n the right side will say 
and will show the title of 

 

your letter’ option.  



Fig. 11.9

From there you can start adding
have linked. For example, hig
and then click on the address b
from your spreadsheet. 

Next go to ‘preview your lette
satisfied click on ‘Complete t
document with a file name or c

It will give you the option to 
print all of the letters from your

 

 

 

 

 

 

Fig. 11.10:

Check Your Progress B 

 State if the following statements a

a) For mail merge document, you 

b) To create Data Source, choose
helper box. 

 

9: Writing Letter 

g your fields from the spreadsheet that you 
ghlight the placeholder marked [Address] 
block. The spreadsheet will pull in the data 

er’. Review the letters created, if you are 
the merge’, you can either save the new 
can print it directly. 

click on ‘print current record’ or you can 
r database 

: Merge to Printer 

are true or false 

need to create the main document. 

e the get data button from the mail merge 
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c) For 
box

d) Afte
mer

e) You

f) Mer

11.5 

Writing 
word eq
equation
equation
section, 

11.5.1  

Go to i
equation

Choose t
the docu

adding a new field, type the name of the f
. 

er creating the main document and data sou
rge the main document with the data source. 

u can directly print the form letters without pr

rge and query are two options available in the

EQUATION EDITOR 

mathematical and scientific equation is a d
quation editor feature makes it simple. Y
ns from its built-in features instantly. Als
ns which are not built-in easily with the help o
we will explain how to use equation editor ef

Starting Equation Editor 

insert tab and click equation to see the a
ns. 

Fig. 11.11: Equation Editor 

the desired equation by clicking it, it will be 
ument. Now click the drop-down button pre

field in the record name 

urce, the third step is to 

reviewing them. 

e merge dialog box. 

difficult proposition. MS 
You can insert common 
so, you can write your 
of equation editor. In this 
ffectively. 

available built-in list of 

 

automatically added into 
sent in the equation box 



for more options. Click change to
edited. 

Fig. 11.12

On clicking the equation will be 
screenshot below.  

Fig. 11.13

For editing equation values, click 
manually.  

Fig. 11.14: Ed

o inline to place it in the line you have 

 

: Change to Inline 

placed properly in line as shown in the 

 

3: Inline Equation  

inside the equation box to change value 

 

diting Equation Values 
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For view
button in
equation

11.5.2  

If you w
Insert Ta

wing or checking equivalent linear equation,
n equation box and click Linear. You can als
n through a single click on Save as New equat

Fig. 11.15: Checking Equivalent Linear E

Creating New Equations 

want to write an equation which is not present
ab and from Equation option, click on Insert N

Fig. 11.16: Creating New Equatio

, click on the drop-down 
so save the newly created 
tion. 

 

Equation 

t in the built-in list, go to 
New Equation. 

 

on 



Upon clicking Equation Tools De
group you can select new equation 
group you can choose different sym

Fig. 11.

Now for inserting another equation 
the document from the Structures gr

Fig. 11

On clicking it will automatically ins

11.6 TRACKING 

Tracking is primarily used for man
Changes feature to mark changes. 
changes.  

11.6.1  Track Changes 

Track changes are used to review
track change got to Review Tab, in
button, track change will be turned 

esign Tab will appear, from the structure 
from a given extended list. From symbols 

mbols to use with equations. 

.17: Design Tab 

chooses the equation you want to insert in 
roup. 

 

.18: Structures 

sert equations into the document.  

naging document revision. Use the Track 
Review a document to accept and reject 

w changes made in the document. To use 
n the tracking group click the track change 
on 
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Track C
right-clic

When y
marking
the track
off. 

Click the

 

 

11.6.2  

Tracking
displaye

By defau

1) Inse

2) Dele

3) Cha
thel

To chang

Note: 
already

Fig.11.19: Track Changes 

Changes indicator can be also activated in th
ck the status bar and select Track Changes. 

Fig.11.20: Options in Track Chang

you turn off track change you can revise
g what was changed. To turn off track chang
king group click the track change button, trac

e Track indicator on the status bar once, the in

Tracking Options  

g options allows you to set how tracked chan
ed. 

ult, changes are displayed in the following wa

ertions (where additional text is entered) are s

 

etions (where text is deleted) are shown with 

 

anged lines (marks all changes) are show
eftof the line or paragraph where a change ha

 

ge how tracked changes are displayed: 

Turing off the Track change does not remov
y been tracked. 

 

he status bar, to activate 

 

ges 

e the document without 
ge got to Review Tab, in 
ck change will be turned 

ndicator will be off. 

nges in the document are 

ay: 

shown with an underline 

a strikethrough 

wn as a vertical line to 
as been made. 

ve any changes that have 



1) Go to Review/Tracking group
Track Changes button. 

2) Select Change Tracking Option

Fig. 11.21: Selecting

The following dialog box will appe
displays 

Fig. 11.22: Cha

11.6.3  Reviewing Changes 

The Changes group on the Review
reject tracked Changes. 

p and click the dropdown arrow on the 

ns 

 

g Change Tracking Options 

ear where you can customize the tracking 

 

ange Tracking Options 

w ribbon can be used to review, accept and 
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The Nex
documen

Use Acc

Use Rej
formattin

When a
indicate 

Check Y

1) Wha

……

……

……

……

……

……

2) Wha

……

……

……

……

……

……

……

Fig. 11.23: Reviewing Changes 

xt and Previous buttons select the next or 
nt. 

cept to accept the change that has been made.

ject to reject the proposed change, and 
ng back to how it was originally. 

all changes have been reviewed, the follow
that there are no tracked changes left in the d

Fig. 11.24: Message Showing No Track Ch

Your Progress C 

at is the utility of Equation Editor? 

…………………………………………………

…………………………………………………

…………………………………………………

…………………………………………………

…………………………………………………

…………………………………………………

at are the common inbuilt functions available

…………………………………………………

…………………………………………………

…………………………………………………

…………………………………………………

…………………………………………………

…………………………………………………

…………………………………………………

 

 

previous change in the 

 

change the wording or 

wing message appears to 
document. 

 

hanges Left 

……………………….. 

……………………….. 

……………………….. 

……………………….. 

……………………….. 

……………………….. 

e in Equation Editor? 

……………………….. 

……………………….. 

……………………….. 

……………………….. 

……………………….. 

……………………….. 

……………………….. 
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3) What are the steps to create a new document and save it? 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

4) What is the utility of tracking in document revision? 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

5) How can we monitor any changes made in the document? 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

6) What are the tracking options available in MSWord? 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

………………………………………………………………………….. 

11.7 REFERENCES 

11.7.1  Footnote or Endnote 

To insert a footnote or endnote: 

1) Place the cursor where the footnote or endnote number is to appear in the 
document text, and go to the References/Footnotes group. 

2) To insert a footnote, click the Insert Footnote button; to insert an 
endnote, click the Insert Endnote button. 

3) Enter the text for the footnote or endnote; then click away from where 
you have typed 
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5) Click Close to exit the dialogue
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11.27: Indexes 

ndex is to appear. 

ck the Insert Index button. 

matting using the Index dialogue box, and 

 
8: Creating Index 

Advanced Tools Using
Word Processing

221



Word Processing 

222 

To inclu
created: 

1) Mar
entr

2) Clic

3) Go 
F9 k

11.7.3  

Word ca
of headi
Heading
Table of
automati
subhead

First we 

To apply

1) Clic
to. 

2) Go 
style

3) Clic
para

Once the
of Conte

1) Posi

2) Go 
Con

3) Sele
Con
appe

 

ude and update additional index entries on

rk the words or phrases to be added to the in
ries’). 

ck within the existing index. 

to References/Index and click the Update In
key. 

Table of Content 

an generate a table of contents automatically, 
ing styles in the document. In simplest te

g 1, Heading 2 or Heading 3 styles applied
f Contents when it is generated. So, to gen
ically it is a must to apply heading styles in

dings. 

need to apply style while developing the con

y a style: 

ck into or select the paragraph (heading) you

to Home/Styles group. Click the dropdown
es available in the Styles gallery. 

ck on the style you wish to use to apply t
agraph. 

e style is applied, we can create the table of 
ents 

ition the cursor where the table of contents is

to References/Table of Contents group a
ntents button. 

ect from one of the preset options in the list;
ntents for further options, and click OK. 
ears at the cursor position. 

Fig. 11.29: Table of Contents 

nce the index has been 

ndex (see ‘Marking index 

ndex button; or press the 

based on the application 
rms, any headings with 

d can be included in the 
nerate a table of content 
n document headings and 

ntent. 

u wish to apply the style 

n arrow to view all the 

the style to the selected 

content. To create Table 

 to appear. 

and click the Table of 

 or select Insert Table of 
The Table of Contents 

 



To update the table of content onc
content.  

1) Click within the Table of Conte

2) Press the F9 key. The following

3) Select Update page numbers on

Fig. 11.30: Upd

To remove the Table of Contents 

1) Go to References/Table of C
Contents button. 

2) Select Remove Table of Conten

11.7.4  Bookmarks 

A bookmark identifies a location 
identify for future reference. Y
bookmarks. 

To create a bookmark 

1) Select the text to be bookmarke

2) Go to Insert/Links group and cl

3) Under Bookmark name, type 
begin with a letter can contain n

4) Click Add. The Bookmark dial

Fig. 11.

ce changes made after creation of table of 

ents. 

g message appears: 

nly or Update entire table, and click OK 

 

ating Table of Contents 

Contents group and click the Table of 

nts. 

or a selection of text that you name and 
You can also add cross-references to 

ed. 

lick the Bookmark button. 

or select a name. Bookmark names must 
numbers but can't include spaces. 

logue box closes. 

 
.31: Bookmarks 

Advanced Tools Using
Word Processing

223



Word Processing 

224 

To locat

1) Go t

2) Sele

3) Clic

 

 

 

11.7.5  

A cross-
to anoth
item, a 
endnote.

Note
select

te an existing bookmark 

to Insert/Links group and click the Bookmark

ect the bookmark name from the list. 

ck Go To. 

 

Fig. 11.32:  Inserting Bookmarks

Fig. 11.33: Find and Replace 

Cross-references 

-reference directs a document reader from on
her. The cross-reference can refer to any of th

heading, a bookmark, a captioned table or
. 

: Pressing the F5 key opens the Go to feature
t a bookmark to go to its location in the docum

k button. 

 
s 

 

ne point in the document 
he following: a numbered 
r graphic; a footnote or 

e in Word, where you can 
ment. 



Advanced Tools Using
Word Processing

225

To create a cross-reference 

1) Enter the text that will be the preamble to the cross-reference – e.g. (see 
[cross Reference]). 

2) Go to Insert/Links and click the Cross-reference button. 

3) Under Reference type, select the appropriate item. 

4) Under Insert reference to, select what will be displayed in the cross-
reference itself. 

5) Click Insert, and then Close. The cross-reference appears in the text. 

 

Fig. 11.34: Cross Reference 

11.7.6  Citation 

To create citation 

1) Go to Reference Tab, click insert citation 

2) To add a citation in the content of the document put the cursor where you 
want to put the citation.  

3) Click on the ‘References’ tab  

4) Click the ‘Insert Citation’ button. If it is the first time you have cited 
from the source then click ‘New Source’, however, if you have used the 
source before then it will appear in the drop-down menu, as shown in the 
picture below.  
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Fig. 11.35: Citation 

5) If you are creating a new source then first you need to choose the type of 
the source, such as a book or an article.  Use the drop-down menu next to 
where it says ‘Type of source’.  

6) Fill the rest of the boxes with the relevant information, such as the 
author, title, year, etc.   

 

 
Fig. 11.36: Create Source 

7) Click OK 

11.7.7  Placeholders 

Placeholders can be used when you want to put a reference in, but you don’t 
have all of the information yet. To put a citation in the main text of the 
document you are typing then put the cursor where you want to put the 
citation.  

1) Click on the ‘References’ tab  

2) Click the ‘Insert Citation’ button. If it is the first time you have cited 
from the source then click ‘Add New Placeholder’. This is shown in the 
figure below.   
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Fig. 11.37: Adding Placeholder 

Managing Sources 
To add or delete some of the information’s from the sources 

1) Click on the ‘References’ tab  

2) Click on the button that says ‘Manage Sources’, in ‘Citations and 
Bibliography’. 

3) You can add, delete and change sources; you can see how the reference 
list looks in the bottom section of this window.   

 

Fig. 11.38: Managing Sources 

11.7.8 Bibliography 

You can use this option to add a bibliography to the end of your piece of 
work.  To do this you must: 

1) Click to put the cursor in the space that you want to put your 
bibliography. 

2) Click on the ‘References’ tab  

3) Click on the ‘Bibliography’ in ‘Citations and Bibliography’ box on the 
ribbon.   

4) You can now choose from Bibliography/Works Cited or Insert 
Bibliography. The first two options (Bibliography and Works Cited) will 
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insert all the sources which are associated with the document (but will 
label them differently depending on which you choose), and the final 
option (Insert Bibliography) will list all the sources that are cited within 
the document. The box that has these options is shown below.  

 

Fig. 11.39: Bibliography 

Check Your Progress D 

State whether the following statements are True or False: 

a)  Footnote or endnote once created cannot be deleted. 

b)  Index and Table of Content are the same things. 

c) Placeholders can be used when you want to put a reference in. 

d)  Cross-reference and bookmark works differently. 

e)  Word can generate a table of contents automatically. 

11.8 LET US SUM UP 

In this unit, we have learned about merging a word document with data 
source so that the multiples copies of the main document can be created 
according to data for different destinations removes the tedious work of 
duplicating  a copy and changing specific information in specific documents 
like name, address etc. All you need to do is create the main document, create 
the data source use the Mail Merge feature available in Mailing Tab to link 
your main document with the data source. Insert the fields from the data 
source to the exact place in the main document where you need them. Merge 
the document. Your new document with multiple copies will be ready for 
printing or editing. 
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Wring equation is always a difficult task in MS Word, all the symbols that 
are used are not available in the keyboard and finding and inserting from 
symbol may be a tedious task. By using the equation editor available in the 
Insert Tab, we can insert common equations also we can create equation of 
our need. 

Tracking option available in MS Word can keep track of the changes made in 
the document once it is created or for reviewing a document. The tracking 
option is available in the Review Tab of MS Word. 

For technical and professional writing MS Word is a great tool all the options 
for referencing like footnote, citation, indexing, table of figure and 
bibliography are available in MS Word. 

11.9 KEY WORDS 

Mail Merge: Mail merge is the process of transferring selected information 
from one document to another document. 

Main Document: In mail merge, Main document is the common letter, 
which contains the common content for each of the merged documents. It 
contains field names which are inserted at required places in the document, 
which contains the instruction for carrying out the merge. 

Data Source: Data source is the records of individuals to who letters to be 
sent also called Data File. The information’s stored in the data files is brought 
into the main document by mail merge. 

Form Letter: Form letter is the document created out of mail merge, which 
contains the content of the main document with each piece of information 
from the data source. 

Equation Editor: MS word equation editor feature makes the writing 
mathematical and scientific equation simple. 

Tracking: Tracking is primarily used for managing document revision. Use 
the Track Changes feature to mark changes. Review a document to accept 
and reject changes.  

Bookmarks: A bookmark identifies a location or a selection of text that you 
name and identify for future reference. 

Cross-references: A cross-reference directs a document reader from one 
point in the document to another. The cross-reference can refer to any of the 
following: a numbered item, a heading, a bookmark, a captioned table or 
graphic; a footnote or endnote. 

Placeholders: Placeholders can be used when you want to put a reference in, 
but you don’t have all of the information yet. 
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11.10 ANSWERS TO CHECK YOUR PROGRESS 

Check Your Progress B 

1) (a) True (b)  True (c) False  (d) ) True (e) False  
(f) True 

Check Your Progress D 

1) a) True b) False  c) True  d) True  e) True 

 

11.11 TERMINAL QUESTIONS 

1) What do you understand by Mail Merge? 

2) Define the different components of Mail Merge. 

3) How do you invoke ‘Mail Merge Helper’ window? 

4) Differentiate between Merge and Query option of ‘Mail Merge Helper’ 
window. 

5) How equation editor can help you write a professional document? 

6) How can you invoke equation editor? 

7) What are the afferent referencing options available in MS Word? 

8) Explain the steps of creating a Table of Content in MS Word. 

9) Differentiate between Bookmark and Cross referencing. 

10) Differentiate between Citation and Bibliography. 

 

Note: These questions are helpful to understand this unit. Do efforts for 
writing the answer of these questions but do not send your answer to 
university. It is only for yours practice. 
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12.0 OBJECTIVES 

After completing this unit, you should be able to: 

understand how to create business reports; 

understand the application and usage of MS word in report writing; 

understand how to write business letters using MS word; 

understand the structure of DPR; and 

understand how to write DPR using MS word. 

12.1 INTRODUCTION 

MS-Word is used for writing a variety of documents. From simple office 
communication, resumes, invitation, memo. Writing this document from 
simple communication to lengthy reports requires a different set of skill set 
what we call professional report writing. Microsoft features help manage 
these large documents, for creation, collaboration and it is also important to 
professionally design and edit the document. Business Report and 
documentation require research and publishing of the analysis. In business 
environment only content will not work, it is very important to have a proper 
look and appearance of the document. This unit guides us to update our 
technique and sharpen our design and documentation skills.  

12.2 CREATING A BUSINESS REPORT 

The report format may vary from organization to organization but broadly if 
we look at it a business report generically will have the following format 

1) Purpose of the Report: It is important to understand why we are writing 
this report. There are many kinds of reports used in business, broadly 
either for information or for perusal. A report may be a technical report 
describing the process and background information or a progress report 
of a project. It is important to answer what and why of writing the report. 

2) Audience of` Report: It is important to evaluate the audience .Who will 
read the report? Will they be able to understand what you are trying to 
communicate? Reader’s knowledge of the subject will greatly influence 
the content that you are creating or kind of information you intend to 
give. 

3) Knowledge of the Topic: It is obvious we must have a thorough 
knowledge of the topic for which you are writing the report. It is 
important to research the topic and include all relevant information to 
prove your point. You can use a variety of resources like journals, 
newspaper articles, books, web etc. 
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4) Outline of the Report: The structure of a business report can include the 
following essentials 

Title Page 

Executive Summary 

Table of Content 

Introduction 

The Body of the Report 

Conclusion  

Recommendation 

Appendix 

Bibliography and Reference  

5) Write, Edit, Proofread and Finish: Once you have structured your 
report, fill out the headers with content. Once the majority of your text is 
written read through it and make sure it flows well. Check for grammar 
and spelling, and double-check all relevant information and its logical 
flow  

12.3 USING MS WORD FOR REPORT WRITING 

Microsoft Word is a great tool for effective report writing. The Microsoft 
Word features we will cover below are also productivity shortcuts that will 
make your job easier.   

12.3.1  Cover Page  

The first page is the first point of contact with your reader. Word has -built 
gallery of title pages. All you have to do is choose one of the available cover 
pages for your report. 

To create cover page 

1) Go to Insert > Pages Group > Cover Page. The cover page appears at the 
beginning of the document by default. 
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1) Auto text 
2) Document property  
3) Field 

 

Fig. 12.11: Quick Parts 

AutoText: It works like Quick Parts for any block of text that you use 
repeatedly. Example: A note you want to use with every document. 

Document Property: A set of constant properties that you can include with 
every document. Example: Company name or author.  

Fields: These are predefined elements that update automatically. Example: 
Date, time, page numbers, etc. 

12.3.11  Page Borders  

 A variety of line styles and widths and art borders are available from the 
Page Layout Tab in the page background group 

 

Fig. 12.12: Page Borders 
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You can change the color, width and even use different art forms for page 
border 

12.3.12  References and Collaboration 

The reference and collaborations as discussed in the previous chapters should 
be applied as and when needed. 

1) Create an Index (see Unit 11) 

2) Creating Bibliographies (see Unit 11) 

3) Cross-Referencing (see Unit 11) 

Check Your Progress A 

1) What is a business report? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

2) What is the utility of quick parts in business report writing? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

3) What are the different referencing styles available in MS Word? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

4) What is the significance of page break in MS word? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 
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12.4 REPORT FINALIZATION 

Finalization is the security measures to protect the report from unauthorized 
changes and plagiarism. These security measures will give an extra level of 
authenticity to your electronic file before you share it. 

 This section will cover:  

Signatures  

Insert watermarks 

Make the document ‘read-only’  

Password protect your document  

Print your document to PDF 

12.4.1 Signature  

You can add text signature for a personal touch to the report. But a simple 
text signature does not need any authentication. A digital signature is the 
better way to protect your document from unauthorized access. A digital 
signature confirms that the document came from the signer and hasn’t been 
tampered in any way. Let’s create a signature line in Microsoft Word  in the 
document, place your cursor where you want to create a signature line.  

1) Go to Insert > Text group > Signature Line and click Microsoft Office 
Signature Line. 

2) The Signature Setup dialog box is displayed. Fill the fields as indicated. 
If you are sending the document to someone else for signing, add 
instructions for the signer in the field reserved for it (Instructions to the 
signer). The signer can also add give the purpose for the signing if the 
Allow the signer to add comments in the Sign dialog box is checked. 

 

Fig. 12.13: Signature Setup 
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Enter a signature: When you need to sign a document with a digital 
signature, go to the signature line and right click on it. You will be prompted 
to sign with a digital ID. If you don’t have one, Microsoft will tell you to get 
one from a signature service partner. 

12.4.2  Watermarks 

A Microsoft Word watermark is a useful visual indicator for the status of the 
document. For example, you can use a watermark that says “Do not Copy”  
or “Confidential”. 

To create a watermark 

1) Go to Page Layout Tab > Page Background and choose Watermark. The 
Watermark button will be enabled in the Print view only. 

 

Fig. 12.14: Watermark 

2) You can choose a picture or a text watermark from the gallery. Both 
horizontal and diagonal versions are available. The dialog box gives you 
all the customization options 

3)  You can type your own text in the Text field to create your custom 
watermark. 

4)  Choose OK to apply the watermark to your document. Word 
automatically applies the watermark to every page except the title page. 
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12.4.3  Make Documents “Read Only” or Password Protect 
or Restrict Editing 

A business report normally should not need to be edited by its readers. We 
have the option of converting the document to PDF format but another option 
we have to keep the beauty of the document we can send a read-only version 
of the Ms Word Document 

To make a document read-only 

1) Go to the File tab > Info > Protect Document > Mark as Final. 

2) When readers open a document, a bar on top will prompt readers to treat 
this document as read-only. But they can click on “Edit Anyway” to 
open the document in Edit mode. 

 

 

Fig. 12.15: Information 

 

 



To Password Protect Your Docum
barrier. 

1) Under Protect Document, ch
password and click OK. 

2) In the Confirm Password box,
OK. The document will open w

Fig. 12.16:

To Restrict Editing to certain part o

1) Under Protect Document, choo
click OK. 

2) Under editing restrictions, che
document, and make sure the li

3) To free some sections from th
editing without restrictions. To
while selecting the area using th

4)  You can check everyone und
Editing panel. Or, click more 
modify the sections. The allo
brackets. 

5)  Click Yes, Start Enforcing Pro

6) Now, type a unique password 
again to confirm it. 
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ESS LETTERS 

Introduction 

n may be the first communication your 
or business contact receives from your 
your initial impression is the key to the 

Creating Business 
Documentation

245



Word Processing 

246 

 

 

 

 

 

 

 

 

 

 

12.5.2  Letter of Intent 

You can use a letter of intent, or letter of interest, in various business 
situations including negotiations, acquisitions, contracts, and purchases. This 
type of communication can help to ensure that the parties are on the same 
page with a clear picture of your organization’s intent. 

 

 

 

 

 

 

 

 

 

 

12.5.3  Memo 

An office memo is a piece of document or a note that is a common source of 
information in a workplace regarding important notices or announcements 
and other 

 

 

Name of Addressee 
Name of Organization 
Address 

Reference: Give a brief reason for the purpose of writing this letter. This can vary 
depending on your needs. While some may be introducing a new product to their 
customers, several others may be informing about their business to their potential 
clients. 

Salutation/Greeting: 
Dear Mr./Ms. 

In the introductory paragraph, you ought to mention about your company (if you 
are introducing it to customers and clients). Include information, like who owns 
the organization and what has been phenomenal about this firm. In case, you are 
introducing your business to new clients to attract funds for business expansion, 
you must begin with an emphatic introduction stating the firm’s year of formation 
and establishment. 

Dear [Name of Recipient]: 

[Short introduction paragraph – indicate you are submitting this letter with the 
intent to do a specific action (purchase, partner, acquire, license, etc.). Indicate that 
the intent is based on the following conditions.] 

[Define the specifics about the item behind the intent listing all pertinent variations 
of the item or supporting material. Provide indication or your intent with respects 
to the liabilities.] 

[Consideration – Propose what you are willing to provide as compensation or other 
as consideration for the specifics listed above. Be sure to define amounts, timing.] 

[Provide conditions for the transaction. This may include conditions on due 
diligence, limitations on further seeking other interested parties or confidentiality.] 

[Indicate that this letter is not an official offer and that all details would need to be 
negotiated and executed through a formal Purchase (or other) Agreement.] 



Creating Business 
Documentation

247

 

 

 

 

 

 

 

 

 

 

12.6 CREATING DETAILED PROJECT REPORT 

Detailed project report is a complete document for investment, decision 
making, approval and planning. Detailed project report is a base document 
for planning the project and implementing the project. The objectives of DPR 
are following: 

To understand the importance of developing a detailed project report that 
assure performance for reliable quality with in optimum cost. 

To appreciate that projects are site specific. 

To understand the importance of optimization of the schemes, detailed 
cost estimate, payback period and return on investment.  

To describe how bankable projects can help to achieve required 
performance. To understand methodology of project appraisal. 

12.6.1 Description of Project Area 

Following is a generic structure of information about the project to be given. 

Name of utility  

District / town (s) village covered  

Location : latitude and longitude  

Area, population, boundaries  Climatic conditions  

Status of development. Access to electricity  

Economic structure – socio – economic features  urban / rural 

12.6.2    Project Cost Details  
Basic Equipment Cost  

Consultant charges  

Memorandum 
To: Recipients’ names and job titles 
From: Writers’ name and job titles 
Date: Complete and current date 
Subject: Description of what memo is about 
 
Begin with a brief introductory paragraph that contextualizes the memo for your 
readers and describes the main point or course of action that readers should take 
after reading the memo. The introduction should not have a heading. 

After the introductory paragraph, the body of the memo should be broken into 
sections with informative headings at the start of each section. These headings 
should not consist of generic words like “Problem” but specific phrases like 
“Avoiding Cost Overruns in Sector 7.” 

Remember that if there are others who will receive copies of memo, aside from the 
recipients, add CC: after the memo subject line with the names of those 
individuals. 
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Duties , Taxes & Freight a) Excise duty / customs duty/ sales tax  

Freight and Transit Insurance  

Raw materials  

Man Power cost  

Engineering Project Management. Supervision  

Interest During Construction 

12.6.3 Project Investment Criteria  

Basically Cost – Benefits analysis  

 Investment criteria can be  

Payback period  

Discounted cash flow (DCF) Technique  
a)  Net Present Worth (NPW) 

b)  Benefit Cost Ratio (B C Ratio)  

c)  Internal rate of return (IRR) 

12.6.4 DPR Structure  

Title Page   

Name, Affiliation, Date etc. 

Acknowledgement  

Content list  

Abbreviation  

Executive Summary  

Introduction  

Background  

Main technical & financial analysis chapters  

Recommended action plan  

Appendices 

12.6.5 Using MS-Word for Creation of DPR 

Title should be in Times New Roman font, size 14 pt, and bold; it should 
be centred across the page 

Name of Author(if any) in 10pt Times New Roman 

All sections should be numbered as in the section heading. The section 
headings should be in Times New Roman, size 14.0 pt, and bold 
typeface. Capitalise the first letters of every word in the section heading, 
except for prepositions such as of, on, for, etc. Do not indent the first line 
of the first paragraph in a section or a sub-section. 
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Subsection headings should be numbered. They should be in Times New 
Roman, size 12, and bold typeface. 

The paper size is A4 

The left and the right margins should be 4.47 cm (1.76 inches), the top 
4.45 cm (1.75 inches), from the top of the paper to the top of the header), 
and the bottom 3.3 cm (1.3 inches from the bottom of the paper to the 
bottom of the footer, i.e., page number). The gap between the bottom of 
the text and footer is 1/3 inches.  

The title and the authors’ names and affiliations are formatted in 8pt 
Times New  

The text in the entire paper, including that in the abstract, should be 
single-spaced. There should be 3 pt (1pt = 1/72 in) space left before each 
paragraph and headings but zero space below. 

Header and footer appear in font size 8 pt.  

The equations are to be typed using the Equation Editor in Word or by 
using MathType. The size should be set to 10 pt. with the equation 
number appearing on the right  

The figures and tables should be centred. The figure caption should be 
placed below the figure  

Table captions should be placed at the top. Tables should be cited in the 
text in the first sentence of this paragraph. 

The footnotes should be used sparingly. When multiple footnotes are 
used, use superscripted numbers to denote them.1 

References should be numbered in the order of their first occurrence. 
They should be cited with [#] at the end of the sentence or in the middle 
as the case may be. T 

The citations should be listed at the end of the paper but before the 
Appendix, if any. The format of the citations is given in the section 
entitled References at the end of the paper. Different types of references, 
such as a book [1], a journal article [2], a conference paper [3], a 
Master’s thesis [4], a Doctoral thesis [5] are given.  

The bibliography style is adopted from “ieeetr.bst”, and the file needs to 
be available at the point of running the “bibtex” command. A copy of the 
file is included in the zipped folder. 

The formatting rules are outlined in this document. This is a generic structure 
may vary from nature of the project, requirement of the stakeholder and 
Government Norms. 
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Check Your Progress B 

1) What is a Detailed Project Report? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

2) What is the generic structure of a DPR? 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

3) Mention the generic formatting style of project report writing. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

……………………………………………………………………………. 

12.7 LET US SUM UP 

Business reports are a type of assignment in which you analyse a situation 
(either a real situation or a case study) and apply business theories to produce 
a range of suggestions for improvement. The format of business report may 
vary from business to business on the basis of the purpose of report, 
according to the audience of report, knowledge of the report, outline of the 
topic etc. Microsoft Word is a great tool for effective report writing. It has 
variety of features to make the job easier such as header and footer, table of 
contents, cover page, page numbers, and font, style the paragraph, page 
breaks, captions, Quick Parts, page border, references, and collaboration, etc.  

Finalization is the security measures to protect the report from unauthorized 
changes and plagiarism. These security measures will give an extra level of 
authenticity to your electronic file before you share it. It has got features like 
adding signatures to the report, inserting watermark, to make the document 
read-only, password protect the document, print the document to the PDF, 
etc. 
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A company letter of introduction may be the first communication your 
potential client, new customer, or business contact receives from your 
organization. With this in mind, your initial impression is a key to the success 
of that relationship. A letter of intent or letter of interest is used in various 
business situations including negotiations, acquisitions, contracts, and 
purchases. This type of communication can help to ensure that the parties are 
on the same page with a clear picture of your organization’s intent. Detailed 
project report is a complete document for investment, decision making, 
approval and planning. It is a base document for planning and implementing 
the project. 

12.8 KEY WORDS 

Business Report: Business reports are a type of assignment in which you 
analyse a situation (either a real situation or a case study) and apply business 
theories to produce a range of suggestions for improvement. 

Appendix: Appendix is defined as the section at the end of a book that gives 
additional information on the topic explored in the contents of the text. An 
example of an appendix is pages at the end of a book containing other 
informational texts about the topic. 

Page Break: A page break splits a continuous block of text across two 
pages. Page breaks are important structural elements for long documents. 
Word automatically inserts a page break at the end of the page. But in a long 
document, you can place page breaks where you want them. 

Signature: A digital signature is the better way to protect your document 
from unauthorized access. A digital signature confirms that the document 
came from the signer and hasn’t been tampered in any way.  

Watermark: A watermark is an identifying image or pattern in paper that 
appears as various shades of lightness/darkness when viewed by transmitted 
light, caused by thickness or density variations in the paper. Watermarks 
have been used on postage stamps, currency, and other government 
documents to discourage counterfeiting.  

DPR: Detailed project report is a complete document for investment, 
decision making, approval, planning. Detailed project report is a base 
document for planning the project and implementing the project. 

12.9 TERMINAL QUESTIONS 

1) Explain how and where referencing to be used in Business report 
writing? 

2) Explain how you can create a table of content in MS Word? 
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3) What is a cover page of business report? How you can create one using 
MS word? 

4) What is the generic structure of business report? 

5) Explain the options we have to protect our document while sharing with 
others. 

6) Explain how we can protect certain portion of the document from 
editing. 

7) What is watermark and how it is used in a document? 

8) Explain how to mark a document as final. 

 

Note: These questions are helpful to understand this unit. Do efforts for 
writing the answer of these questions but do not send your answer to 
university. It is only for yours practice. 
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